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ABSTRACT 

This tutorial explains in detail what factorial validity is and how to run its various aspects in PLS. 
The tutorial is written as a teaching aid for doctoral seminars that may cover PLS and for 
researchers interested in learning PLS. An annotated example with data is provided as an 
additional tool to assist the reader in reconstructing the detailed example.  
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I. INTRODUCTION  

Since we first published our tutorial “Structural Equation Modeling Techniques and Regression: 
Guidelines for Research Practice” in Communications of AIS [Gefen et al. 2000] and its follow-up 
“Validation Guidelines for IS Positivist Research” [Straub et al., 2004], we have received many 
emails about the practicalities of running PLS (Partial Least Squares) and LISREL. In consultation 
with the editor of CAIS, we are publishing this addendum to the Guidelines. The objective of this 
particular short guide is to describe how to run factorial validity and how to examine it through 
PLS. Specifically, the tutorial discusses and demonstrates convergent and discriminant validity, 
including the AVE analysis. This tutorial is aimed at researchers aiming to adopt PLS-Graph but 
still unaware of how to actually assess factorial validity through it.  

II. THEORETICAL BACKGROUND 

Factorial validity is important in the context of establishing the validity of latent constructs. Latent 
constructs, also known as latent variables, are research abstractions that cannot be measured 
directly, variables such as beliefs and perceptions. Quantitative positivist researchers assume 
that while some variables such as gender and age can be measured directly and with little error, 
a major difficulty arises with surrogates where the abstraction is removed from objective reality.1 
                                                      
1 See http://dstraub.cis.gsu.edu:88/quant/ for greater detail.  



92                              Communications of the Association for Information Systems (Volume 16, 2005) 91-109    

A Practical Guide to Factorial Validity Using PLS-Graph: Tutorial and Annotated Example by D. Gefen and 
D. Straub 

Because such abstractions cannot easily be measured through direct means, agreed-upon 
practice dictates that they be measured indirectly through several items in a research instrument 
[Anderson and Gerbing, 1988, Bagozzi, 1977, Campbell and Fiske, 1959, Churchill, 1979]. Each 
measurement item, i.e., each actual scale item on an instrument, is thus assumed to reflect one 
and only one latent variable. This property of the scale, having each of its measurement items 
relate to it better than to any others, is known as unidimensionality. Unidimensionality is 
discussed in detail by Gerbing and Anderson [1988] and is delineated in another CAIS tutorial 
[Gefen 2003]. Unidimensionality cannot be measured with PLS but is assumed to be there a priori 
[Gefen, 2003, Gerbing and Anderson, 1988].  

However, two elements of factorial validity can and must be examined in PLS, as they must be 
with latent variables in general [Churchill, 1979, Gerbing and Anderson, 1988]. The two elements, 
convergent validity and discriminant validity, are components of a larger scientific measurement 
concept known as construct validity [Straub et al., 2004]. These two validities capture some of the 
aspects of the goodness of fit of the measurement model, i.e., how well the measurement items 
relate to the constructs. When factorial validity is acceptable, it means each measurement item 
correlates strongly with the one construct it is related to, while correlating weakly or not 
significantly with all other constructs. Typically, because of the way factorial validity is established 
in PLS, this pattern of factorial validity is divided into convergent validity and discriminant validity. 
Convergent validity is shown when each measurement item correlates strongly with its assumed 
theoretical construct, while discriminant validity is shown when each measurement item 
correlates weakly with all other constructs except for the one to which it is theoretically 
associated.  

In first generation regression models, factorial validity was most frequently assessed with an 
Exploratory Factor Analysis, or EFA.2 Several estimation methods can be used in an EFA. The 
objective of all these methods is generally the same, however. This objective is: 

• To establish that the measurement items converge into the appropriate number of 
theoretical factors, 

• That each item loads with a high coefficient on only one factor, and  
• That this one factor is the same factor for all the measurement items that supposedly 

relate to the same latent construct [SPSS, 2003].  

As a rule of thumb, a measurement item loads highly if its loading coefficient is above .60 and 
does not load highly if the coefficient is below .40 [Hair et al., 1998]. Technically, an EFA 
identifies the underlying latent variables, or factors, that explain the pattern of correlations within a 
set of measurement items. Once this data reduction identifies a small number of factors that 
explain most of the variance in the measurement items, the loading pattern of these 
measurement items is determined and revealed in the statistical output. The number of factors 
that is selected by default is the number of factors with an eigenvalue exceeding 1.0. Sometimes, 
more or fewer factors are selected by the researcher based on a scree test or on theory [Hair et 
al., 1998].  

                                                      
2  In EFA, the number of factors is not stated in advance by the researcher. The computer program, such as 
SPSS or SAS, calculates the relationships between all the measurement items, placing those most closely 
related (highly correlated) into factors, which are then matched to the researcher’s theoretically posited 
constructs.  A researcher can also specify a certain number of factors to be extracted within EFA and rotate 
the matrix. An EFA involves two statistical stages. In the first stage the factors as extracted. In the optional 
second stage, the factors are then rotated to provide a better picture of the underlying factors of the 
measurement items. There are several methods of extracting factors. The most common one that we see in 
IS studies is a Principal Components Analysis (PCA). An EFA enables specifying the expected number of 
factors, but although this is a move from being entirely exploratory, it not a confirmatory analysis in the 
sense of a CFA where the pattern by which measurement items load onto certain factor is specified in 
advance.  
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These two steps are typically carried out through a Principal Components Analysis, or PCA, 
which extracts the factors assuming uncorrelated linear combinations of the measurement items. 
The loading pattern is then rotated to simplify the interpretation of the results. Typically this 
rotation is a Varimax rotation which creates orthogonal factors with minimized high loadings of the 
measurement items on other factors. Another common rotation method is the Direct Oblimin 
Method which performs a nonorthogonal or oblique rotation [SPSS, 2003].  Nonorthogonal 
rotations can produce a neater pattern of loading, and so they make the interpretation of the 
factors easier, but at the cost of increasing multicollinearity because of the loss of orthogonality.3  

Both EFA and PCA are run via programs like SPSS, which calls this approach “data reduction.”  
In a sense, researchers are attempting to achieve data reduction in that items that do not load 
properly are dropped and the instrument thereby “purified” and by reducing the larger number of 
measurement items into a smaller number of factors [Churchill, 1979].  With the advent of 
structural equation modeling (SEM) tools, such as PLS and LISREL, an argument for not 
purifying measures and treating an instrument more holistically has been made [MacCallum and 
Austin, 2000, Straub et al., 2004], but there is no clear resolution about whether measurement 
error should be modeled and accounted for or simply eliminated. 

PLS FACTORIAL VALIDITY  

In contrast to EFA, PLS performs a Confirmatory Factor Analysis (CFA). In a CFA, the pattern of 
loadings of the measurement items on the latent constructs is specified explicitly in the model. 
Then, the fit of this pre-specified model is examined to determine its convergent and discriminant 
validities. This factorial validity deals with whether the pattern of loadings of the measurement 
items corresponds to the theoretically anticipated factors.4 The example presented in Section III 
details how this analysis is performed.  

Convergent validity is shown when each of the measurement items loads with a significant t-value 
on its latent construct. Typically, the p-value of this t-value should be significant at least at the 
0.05 alpha protection level.  

Discriminant validity is shown when two things happen: 

1. The correlation of the latent variable scores with the measurement items needs to 
show an appropriate pattern of loadings, one in which the measurement items load highly 
on their theoretically assigned factor and not highly on other factors.  

Established thresholds do not yet exist for loadings to establish convergent and 
discriminant validity. In fact, comparing a CFA in PLS with a EFA with the same data and 
model, Gefen et al. [2000] showed that loadings in PLS could be as high as .50 when the 
same loadings in an EFA are below the .40 threshold. Nonetheless, in our opinion, all the 
loadings of the measurement items on their assigned latent variables should be an order 
of magnitude larger than any other loading. For example, if one of the measurement 

                                                      
3 Other than the statistical assumptions of independence of antecedent variables (this is why they are called 
“independent variables,” in fact), there is no inherent scientific reason to prefer orthogonal rotations to 
oblique rotations.  Oblique rotations are, perhaps, more in keeping with the real world where constructs 
frequently overlap both conceptually and statistically.  
4 The discussion assumes that the measurement items are reflections or “reflective” of the construct, which 
means that all items should correlate highly with each other.  We do not deal with the issue of how to 
validate an instrument when the items (or sub-constructs) are thought to be “formative.”  For all intents and 
purposes, formative measures are still an open issue in the metrics literature. Initial guidelines on 
constructing indexes with formative measurement items are discussed by Diamantopoulos and Winklhofer 
[2001].   
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items loads with a .70 coefficient on its latent construct, then the loadings of all the 
measurement items on any latent construct but their own should be below .60.   

2. Establishing discriminant validity in PLS also requires an appropriate AVE (Average 
Variance Extracted) analysis. In an AVE analysis, we test to see if the square root of 
every AVE (there is one for each latent construct) is much larger than any correlation 
among any pair of latent constructs. AVE, which is a test of discriminant validity offered 
through PLS, is calculated as:  

(Σλi
2)/( (Σλi

2) + (Σ(1-λi
2) ) 

             where λi is the loading of each measurement item on its corresponding construct. 

AVEs are generated automatically using the bootstrap technique by the latest version of PLS-
Graph (i.e., version 03.00 build 1126 of 2003). AVE measures the variance captured by a latent 
construct, that is, the explained variance. For each specific construct, it shows the ratio of the 
sum of its measurement item variance as extracted by the construct relative to the measurement 
error attributed to its items. As a rule of thumb, the square root of the AVE of each construct 
should be much larger than the correlation of the specific construct with any of the other 
constructs in the model [Chin, 1998a] and should be at least .50 [Fornell and Larcker, 1981a].5 
Unfortunately, guidelines about how much larger the AVE should be than these correlations are 
not available. Conceptually, the AVE test is equivalent to saying that the correlation of the 
construct with its measurement items should be larger than its correlation with the other 
constructs. This comparison harkens back to the tests of correlations in multi-trait multi-method 
matrices [Campbell and Fiske, 1959], and, indeed, the logic is quite similar. 

III. PRACTICAL EXAMPLE 

To show how these principles apply in research practice, we next illustrate the testing of factorial 
validity via PLS.  Data used below is from a study that deals with purchasing tickets online and 
tested via the Technology Acceptance Model (TAM) [Davis, 1989].  The study, Gefen [2003], is 
useful in this context since it shows how to apply tests of discriminant validity. A subset of the 
items has been selected for this practical example (Table 1). Basically, as in TAM, the perceived 
ease of use (PEOU) of an IT, which is the website in this case, affects its perceived usefulness 
(PU), and both PEOU and PU affect intended use (USE). Although, as in other studies, we do not 
expect PEOU to have a direct effect on USE (Intention to Use) because PEOU is not of an 
intrinsic value to the information technology being used [Gefen and Straub, 2000]. USE is 
represented as the “Buy Tickets” behavioral intention in the figures that follow. The raw data are 
shown in Appendix I. The raw data were collected from subjects who answered each item on a 1 
to 7 Likert scale ranging from Strongly Disagree through Neutral to Strongly Agree.  

 

 

 

 

                                                      
5 An alternative and more stringent approach of comparing the AVE with the correlations of the 
latent constructs is presented by Gefen et al. [2000] and by House et al. [1991] who suggest 
comparing the AVE, rather than the square root of the AVE, with the correlations. If the AVE is 
larger than the correlation, then the square root of the AVE will always be larger too. The logic 
behind Gefen et al.’s [2000] more stringent approach reflects the over-estimation of paths by PLS 
[Chin et al., 2003].  
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Table 1. Measurement Items in the Example 

Item Wording Item Code 
Travelocity.com is easy to use PEOU1 
It is easy to become skillful at using Travelocity.com PEOU2 
Learning to operate Travelocity.com is easy PEOU3 
Travelocity.com is flexible to interact with PEOU4 
Travelocity.com improves my performance in flight searching and buying PU1 
Travelocity.com enables me to search and buy flights faster PU2 
Travelocity.com enhances my effectiveness in flight searching and buying PU3 
Travelocity.com makes it easier to search for and purchase flights PU4 
I would use my credit card to purchase from Travelocity.com USE1 
I would not hesitate to provide information about my habits to Travelocity USE2 
 

ASSESSING FACTORIAL VALIDITY IN PLS 

Convergent Validity  
To assess factorial validity, we first examine the convergent validity of the scales. To do so, we 
must first build the PLS-Graph model. The model as run in the example is shown in Figure 1.   

 

Figure 1. PLS-Graph Model 

Next, we generate the t-values with a bootstrap, as shown in Figure 2.6  

                                                      
6 The two options to generate t-values in PLS are bootstrap and jackknife. In this example, we use bootstrap 
because it also generates the AVEs in the latest version of PLS-Graph.  
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Figure 2 Extracting PLS-Graph Model 

The generated t-values are not shown graphically. We need to access the results file to view 
these results. Carrying this process out involves two steps. First, we must change the requested 
output to *.out. We select the View menu and click on Show *.out, (Figure 3).  

 

 

Figure 3. Selecting the View the Out file 

 

And then again in the View menu, select Results, as shown in Figure 4. 
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Figure 4. Selecting the Results 

 

This selection opens a Notepad file with the results displayed. Figure 5,shows  part of what the 
file looks like. Convergent validity is shown when the t-values of the Outer Model Loadings are 
above 1.96. The t-values of the loadings are, in essence, equivalent to t-values in least-squares 
regressions. Each measurement item is explained by the linear regression of its latent construct 
and its measurement error.   

 DISCRIMINANT VALIDITY: PROCEDURE 1 

As described in Section II, two procedures are used for assessing discriminant validity: 

1. Examine item loadings to construct correlations.  

2. Examine the ratio of the square root of the AVE of each construct to the correlations of this 
construct to all the other constructs.   
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                                                             Figure 5. Bootstrap Outputs 

                                                                         

 

 Figure 5. Bootstrap Outputs  
Outer Model Weights: 
====================================================     
Original    Mean of     Standard    T-Statistic 
                    sample      subsamples  error       estimate 
Buy Tick: 
    Use1            0.5278      0.5321      0.0707      7.4690 
    Use2            0.5782      0.5697      0.0637      9.0817 
 
PU      : 
    pu1             0.2851      0.2699      0.0337      8.4618 
    pu2             0.1962      0.2054      0.0354      5.5438 
    pu3             0.3419      0.3397      0.0290     11.7764 
    pu4             0.3686      0.3737      0.0419      8.7960 
 
PEOU    : 
    eou1            0.2921      0.2894      0.0511      5.7192 
    eou2            0.2993      0.3107      0.0520      5.7600 
    eou3            0.2654      0.2572      0.0497      5.3444 
    eou4            0.3414      0.3546      0.0964      3.5410 
 

 

 

 

 

 

 

 

 

Outer Model Loadings: 
======================================================       
Original    Mean of     Standard    T-Statistic 
                    sample      subsamples  error 
                    estimate 
Buy Tick: 
(Composite Reliability =      0.899 , AVE =      0.817 ) 
    Use1            0.8945      0.8995      0.0357     25.0546 
    Use2            0.9130      0.9101      0.0413     22.1054 
PU      : 
(Composite Reliability =      0.899 , AVE =      0.690 ) 
    pu1             0.8140      0.8024      0.0665     12.2350 
    pu2             0.7603      0.7632      0.0651     11.6852 
    pu3             0.8782      0.8794      0.0333     26.3716 
    pu4             0.8641      0.8698      0.0218     39.5831 
PEOU    : 
(Composite Reliability =      0.902 , AVE =      0.698 ) 
    eou1            0.8085      0.7823      0.0879      9.1973 
    eou2            0.8171      0.8035      0.0870      9.3953 
    eou3            0.8677      0.8524      0.0629     13.7857 
    eou4            0.8464      0.8406      0.0523     16.1918 
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Extracting the necessary data requires a change to the default output file. To make this change, 
first select the Output option in the Options menu, as shown in Figure 6, and then request the 
Latent variable scores, as shown in Figure 7.  

 

 

Figure 6. Selecting Set the Output Options 

 

 

Figure 7. Setting the Output Options 

The item loadings on the constructs (latent variables) are calculated based on these scores.  
Once these scores are generated, we can extract the relevant values, as shown in Figure 8. 
Figure 8 already shows the graphical results of this extraction. The number above each path from 
item (in boxes) to latent variable (in circles) is the item loading. The number below each path in 
brackets is the item weight. The number below each circle is the construct R2, which is calculated 
and displayed for each variable that is a dependent variable in the model, in this case, PU and 
Buy Tickets. 
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Figure 8. Displaying the PLS-Graph Model 
 

To view the detailed output we must first revert back to the 1st output file by clicking on it in the 
View menu, as shown in Figure 9.  

 

 

Figure 9: Selecting the View the 1st  file 
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To view the 1st file, select Results in the View menu. The Notepad file will contain several 
sections, one of these is labeled ‘Eta  ..Latent variables’ (Figure 10). This section appears only 
because we explicitly requested latent variable scores.  The Eta of the first 20 observations, or 
data points, are shown here. The number of Etas is the number of data points in the data. PLS-
Graph copies the label of each construct as the header of each column in the output 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

Figure 10. Eta … Latent Variables 

 

To correlate these latent variable scores with the original items, we copy them, after some minor 
editing, into SPSS together with the original data in the Appendix, as shown in Figure 11.  The 
arrow shows these scores copied from the PLS output file into an SPSS file.  

 

 

 

 

 

 

 

 

 

 

 

Eta  .. Latent variables 
 ======================================== 
             Buy Tick       PU        PEOU     
            ---------------------------------------- 
 c1             1.078     0.982     0.128 
 c2             1.723     0.462    -0.498 
 c3            -1.501    -0.111    -1.321 
 c4            -0.211     0.681     1.220 
 c5            -0.510    -0.442     0.084 
 c6             0.433    -0.442    -0.185 
 c7            -0.856    -1.398    -0.454 
 c8             0.433     0.299    -0.185 
 c9            -0.558    -0.579     0.128 
 c10           -0.211    -0.959    -0.716 
 c11            0.135     1.556     0.682 
 c12           -0.259     1.637     0.425 
 c13            0.874     0.651     1.287 
 c14           -0.164    -0.225     0.951 
 c15           -1.501    -1.398    -1.321 
 c16           -0.211     0.048     0.179 
 c17            2.022     0.756    -0.739 
 c18            0.135     0.323    -1.008 
 c19           -0.809    -0.743    -0.169 
 c20            0.433    -0.442    -0.185 
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Figure 11. Analyzing Example Data in SPSS with the Latent Variable Scores from PLS 

 
With this step completed, bivariate correlations can be run.  If the data is deemed to be interval or 
ratio data with a normal distribution, then Pearson correlations [Figure 12] are acceptable.  If the 
data could violate distributional assumptions or is ordinal, then use the nonparametric Spearman 
correlations [SPSS, 2003].  These values will be very close to the Pearson correlations and have 
only one small disadvantage: their power is slightly lower.[Siegel and Castellan, 1988].7  

 

 

 

 

 

 

 

 

                                                      
7 An excellent tutorial on this topic is available at http://www.statsoft.com/textbook/stbasic.html  
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Figure 12. The Correlations as Produced by SPSS 

Next, with some editing in Excel, copy the correlation table produced in SPSS and shown in 
Figure 12 to produce the correlation table shown in Figure 13. The bold-faced formatting of the 
numbers was added manually in Figure 13 to emphasize the loading of the measurement items 
on the constructs to which they are assigned in the CFA.  
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Bold face shows loading of the measurement items on the 
constructs to which they are assigned in the CFA. 

 

Figure 13. Excel Editing of the Correlation Table 

Although the loadings might seem high, it is common to have much higher loadings in PLS than 
in a PCA. To demonstrate this, the same data are also shown here in a PCA where they 
demonstrate much lower loadings (Figure 14). The high loadings per construct are emphasized in 
bold font.  

Component 

 1 2 3 

eou3 .894 .092 .072 

eou2 .784 .178 .115 

eou1 .782 .167 .114 

eou4 .771 .310 .047 

pu2 .097 .856 -.034 

pu1 .159 .810 .164 

pu3 .261 .772 .260 

pu4 .337 .700 .294 

Use1 .030 .186 .883 

Use2 .186 .144 .870 

                                                      Extraction Method: Principal Component Analysis. 
Rotation Method: Varimax with Kaiser Normalization. 

                                                      Rotation converged in 5 iterations. 
Figure 14. PCA with a Varimax Rotation of the Same Data 



Communications of the Association for Information Systems (Volume 16, 2005) 91-109                           105 

   A Practical Guide to Factorial Validity Using PLS-Graph: Tutorial and Annotated Example by D. Gefen and 
D. Straub

DISCRIMINANT VALIDITY: PROCEDURE 2 

The second procedure necessary to show discriminant validity is the AVE analysis. The square 
root of the AVE of each construct needs to be much larger, although there are no guidelines 
about how much larger, than any correlation between this construct and any other construct. The 
AVEs were already extracted in the bootstrap shown in Figure 5. We take the square root of each 
of these and compare them with the construct correlations in the 1st file, shown in Figure 15. In 
the case of these data, all the square roots are much larger than any correlation, which combined 
with the correlation of the scores to the items shows a necessary aspect of the discriminant 
validity of the latent constructs.  

 

 

 

 

 

 

 

 

Figure 15. Correlations in the lst file as compared with the Square Root of the AVE 

IV. CONCLUSION 

In this tutorial supplement to Gefen et al. [2000], we demonstrate the practical side of using PLS-
Graph to argue for the factorial validity of constructs.  As explained in  Straub et al. [2004], 
factorial validity is a form of construct validity that uses statistical tools that work with factor 
structures.  The purpose of factorial validity is the same as in any examination of the validity of 
constructs, that is, to show that constructs that are posited to be made up of certain measurement 
items are, indeed, made up of those items, and not made up of items posited to be part of 
another construct.  In short, these tests show the convergent and discriminant validity of the 
constructs [Campbell and Fiske, 1959]. 

IS as a field often selects PLS as a tool of choice along with LISREL and standard regression.  It 
is important, therefore, that quantitative positivist researchers use these tools properly and to their 
maximal advantage.  This paper is designed to contribute to this goal. 

ADDITIONAL READING 

On PLS in general and guidelines: [Barclay et al., 1995, Chin, 1998a, Chin, 1998b, Fornell and 
Bookstein, 1982, Fornell and Larcker, 1981a, Fornell and Larcker, 1981b, Gefen et al., 2000] 

On Interaction effects in PLS: [Chin et al., 2003] 

Editor’s Note: This article was received on June 8, 2005 and was published on July __, 2005 
 
 
 
 
 
 
 

Correlations of latent variables   
 

====================================== 
           Buy Tick  PU        PEOU     
             ---------------------------------------- 
 Buy Tick       1.000 
 PU                0.418     1.000 
 PEOU           0.266     0.497     1.000 
 

====================================== 

 AVE 
SQRT of 
AVE 

Buy 
Ticket  0.817 0.903881

PU 0.69 0.830662

PEOU 0.698 0.835464
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APPENDIX 1: THE RAW DATA FILE 
 
eou1 eou2 eou3 eou4 pu1 pu2 pu3 pu4 Use1 Use2 
3 2 2 2 3 4 3 4 5 5 
1 2 2 2 2 2 2 5 6 6 
1 1 1 1 2 4 2 2 1 1 
3 4 3 3 3 4 3 3 3 3 
2 3 2 2 2 2 2 2 2 3 
2 2 2 2 2 2 2 2 4 4 
2 1 2 2 1 1 1 1 2 2 
2 2 2 2 2 3 3 3 4 4 
3 2 2 2 2 1 1 3 3 2 
2 1 1 2 1 2 2 1 3 3 
3 2 3 3 3 4 4 5 3 4 
3 3 1 3 4 5 4 4 4 2 
4 2 3 4 4 4 1 4 2 7 
3 3 3 3 3 2 2 2 2 4 
1 1 1 1 1 1 1 1 1 1 
4 2 1 2 3 2 3 2 3 3 
2 2 1 1 6 4 2 2 7 6 
2 1 1 1 4 4 2 2 3 4 
3 1 3 1 2 2 2 1 1 3 
2 2 2 2 2 2 2 2 4 4 
1 1 1 1 2 2 2 2 3 2 
2 1 2 2 2 2 2 2 1 1 
2 2 5 4 2 2 2 2 2 2 
2 2 2 2 2 3 3 3 3 3 
2 3 2 5 4 3 4 4 3 7 
1 1 1 1 1 1 1 1 2 2 
1 1 1 1 3 2 2 2 3 3 
2 3 2 2 2 2 3 2 2 2 
2 2 3 2 5 5 4 4 3 4 
1 1 1 1 1 1 1 1 2 2 
2 1 3 2 1 1 1 1 1 7 
1 2 3 3 3 3 3 3 5 4 
2 2 2 2 3 4 4 3 7 5 
2 2 2 2 1 2 1 1 2 2 
3 3 3 3 1 1 1 1 2 2 
2 2 2 2 2 1 2 1 1 1 
2 2 1 2 2 1 1 1 5 4 
1 1 1 1 1 1 2 1 2 2 
2 1 3 3 4 3 3 4 2 3 
3 4 3 3 2 3 3 2 3 2 
1 1 1 1 3 1 1 1 1 1 
2 2 2 2 1 3 1 2 3 3 
2 2 2 3 3 4 4 3 6 4 
2 3 2 2 4 4 4 4 3 3 
3 4 3 4 4 3 3 2 3 4 
2 1 1 4 5 6 1 1 4 2 
1 1 1 1 2 2 2 2 4 4 
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2 2 2 1 1 2 1 2 1 3 
2 2 2 2 2 5 4 2 4 4 
1 1 1 2 1 2 2 2 3 4 
2 2 1 4 6 2 7 4 7 7 
3 3 3 3 1 1 2 4 7 5 
3 1 1 1 3 2 3 4 6 7 
2 2 2 3 2 2 2 2 2 2 
2 2 2 2 2 3 2 3 1 1 
1 2 1 1 2 1 1 2 1 1 
2 2 2 3 2 4 3 3 2 3 
2 2 2 2 2 2 2 3 4 4 
1 2 1 1 3 2 3 2 4 5 
2 2 2 2 2 1 1 1 1 3 
2 2 2 2 2 2 2 2 2 3 
2 2 2 2 2 2 2 1 1 4 
2 4 4 4 3 3 4 6 3 6 
2 2 2 3 5 4 5 4 2 2 
1 1 1 2 2 3 3 1 2 4 
2 2 2 5 7 4 7 5 5 6 
1 1 1 1 2 1 2 1 3 2 
3 1 1 1 2 2 2 2 6 3 
2 2 1 2 3 4 2 2 1 1 
2 1 1 2 5 1 1 1 3 3 
1 1 1 2 3 2 2 3 3 3 
2 1 1 1 1 1 2 1 7 7 
2 6 4 3 2 3 3 3 7 7 
3 3 3 2 4 3 4 3 3 3 
3 2 3 3 2 1 2 2 3 3 
2 2 2 2 1 1 1 1 3 3 
4 4 4 4 3 3 3 4 4 4 
7 7 7 7 7 5 7 6 7 7 
1 2 1 2 2 1 1 1 5 5 
1 6 1 2 3 3 2 2 2 2 
3 2 3 3 2 2 2 2 6 3 
3 3 2 3 3 1 2 2 1 7 
2 2 2 2 1 1 2 2 1 1 
2 3 3 3 3 2 2 2 2 4 
3 3 3 5 2 2 3 2 2 2 
2 2 2 2 3 3 2 4 4 4 
1 1 1 1 4 2 1 1 3 4 
1 1 1 1 4 4 4 4 2 2 
3 4 3 5 5 3 2 5 4 4 
1 2 1 2 2 2 1 2 1 2 
1 2 2 2 2 2 2 2 6 5 
2 2 2 2 2 2 2 2 7 7 
3 2 2 3 2 2 3 2 4 4 
3 2 2 3 2 3 3 3 2 2 
2 2 3 3 4 3 3 2 3 3 
2 2 2 6 2 1 2 1 1 2 
4 3 3 2 4 4 3 3 1 4 
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1 3 2 2 3 2 4 3 4 4 
1 2 1 3 2 3 2 2 1 3 
3 4 3 4 3 1 2 1 3 3 

 
 

LIST OF ABBREVIATIONS 

AVE = Average Variance Extracted 

CFA = Confirmatory Factor Analysis 

EFA = Exploratory Factor Analysis 

PCA = Principal Components Analysis 

PEOU,= Perceived Ease of Use, A central component in TAM, the Technology Acceptance 
Model.  

PU = Perceived Usefulness, A central component in TAM, the Technology Acceptance Model. 

USE = Intended Use of a new information system. A central component in TAM, the Technology 
Acceptance Model. 

PLS = Partial Least Squares. A structured equation modeling estimation technique which 
generates estimation of item loadings and path coefficients simultaneously.  

PLS-Graph  = A software package which applies PLS.  
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